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PURPOSE 
The following guide provides step-by-step instructions on how to complete the OLB set-up, 

enabling terminals to connect to the OTCnet Online Application without Java Applets.  

Note: Many of the Printable Job Aids included in this guide are related to Check Capture. The 

steps presented in these guides enable users to set-up their OLB profiles and enable the OLB to 

support Card Processing, Check Capture, Check Processing and Terminal Configuration 

Operations. 

SECTION I: PREPARE FOR THE OLB SETUP 
Complete the following steps to ensure system requirements are met. 

1. Check system requirements to complete any necessary configurations.

• Refer to the OTCnet System Requirements and Reference Guide:

https://fiscal.treasury.gov/files/otcnet/otcnet-sys-req.pdf

• Review the following sections in the guide:

• General Requirements (page 3)

• OLB Prerequisites (page 4)

• Check Processing Requirements (page 5)

• Check Capture Hardware/Scanner Requirements (pages 6)

• OTCnet Card Processing Requirements (page 9)

2. For OLB version 2.5.0.0 and newer, the bundled Java Runtime Environment (JRE)
was removed from the OLB installer. The OLB installer now verifies whether Java is
installed on the workstation, and if the Java version is one that OTCnet supports. If
Java is not installed on the workstation, Windows Administrator privileges are required
to install Java. Refer to the Install the OTCnet Local Bridge (OLB) Application (PJA):
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_download_ol
b.pdf

3. Confirm the installed OTCnet Firmware is 4.3.0.

• To upgrade the Firmware, refer to the Download Firmware Printable Job Aid (PJA):
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_download
_firmware.pdf

• To install the Firmware, refer to the Install Firmware PJA:

https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_install_fir

mware.pdf

Note: Firmware is only required for Check Processing; it is not required for Card Processing. 

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
https://fiscal.treasury.gov/files/otcnet/otcnet-sys-req.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_download_olb.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_download_olb.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_download_firmware.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_download_firmware.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_install_firmware.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_install_firmware.pdf
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4. Modify Internet Explorer Internet Settings as needed. Skip this step if using Microsoft

Edge or Google Chrome.

• On June 15, 2022, Microsoft ended support for Internet Explorer 11 (IE 11).
Windows 10 and 11 do not support IE 11. As a result, OTCnet users are strongly
encouraged to:

o Use Google Chrome or Microsoft Edge
o Upgrade to the latest firmware (check processing only)
o Upgrade to the latest OLB (check and card processing only)

• Review the OLB Prerequisites section of the OTCnet System Requirements and
Reference Guide (page 4).

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
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SECTION II: DOWNLOAD AND INSTALL THE OLB APPLICATION 
Once the system is prepared for OLB installation, complete the following steps to install the 
application.   

1. Download the OLB Application Installation Package.

• For guidance, refer to the Download OLB Application PJA:

https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_download

_olb.pdf

Note: Only the Check Capture Administrator (CCA) and the Card Administrator (CA) are 

authorized to download the OLB Application Installation Package. After the OLB Application’s 

Installation Package is downloaded, any user role with Windows Administrator privileges can 

complete the installation and setup of the OLB. 

2. Install the OLB Application.

• For guidance, refer to the Install the OLB Application PJA:

https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_install_OL

B.pdf

• It is recommended to use the default Server Port Settings during the OLB

installation process. If you would like to modify Server Port Settings, contact the

OTCnet Customer Support Team for assistance.

Note: Each user will need to download and install the OLB Application installation package for 

access. For multiple users assigned to a shared terminal, it is recommended that the Agency IT 

Administrator use the mmc.exe approach to install the OLB Application on a shared workstation. 

This will bypass the need for each user to install the OLB Application under their individual 

workstation login.  

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_download_olb.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_download_olb.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_install_OLB.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_install_OLB.pdf
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SECTION III: CREATE AN OLB PROFILE AND IMPORT OLB 
CREDENTIALS 
Each Check Capture, Check Processing, and Card Processing user (e.g., Check Capture 
Administrator, Check Capture Supervisor, Check Capture Lead Operator, Check Capture 
Operator, Card Administrator or Card Operator) must complete the following steps to create 
individual OLB credentials for access.  

1. Create the OLB Profile.

• For guidance, refer to the Create the OLB Profile PJA:

https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_create_o

lb_profile.pdf

Note: The OLB password never expires. To reset the password, a new OLB profile will need to 

be created. Users’ OTCnet Online passwords are not connected or tied to their OLB passwords. 

Therefore, updated OTCnet Online passwords do not impact or change users’ OLB passwords.  

2. Import OLB Credentials.

• To ensure successful import, refer to the Import OLB Credentials PJA:

https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_import_o

lb_credentials.pdf

Note: Users who access OTCnet on multiple terminals can save their OLB credential file to a 

shared folder (if accessible). Users can then import their unique OLB credential on each terminal. 

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_create_olb_profile.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_create_olb_profile.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_import_olb_credentials.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_import_olb_credentials.pdf
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SECTION IV: START THE OLB 
Each user will need to complete the following steps to launch the OLB and conduct Check 
Processing, Check Capture, and Card Processing activities.  

1. Start the OLB Application.  

• To ensure successful launch of the OLB, refer to the Start and Stop the OLB 

Application PJA: 

https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_start_sto

p_olb.pdf 

Note: There is no “timeout” with the OLB Application (i.e., a suspension or break in OTCnet 

activity). Therefore, the OLB Application will stay connected unless one of the following occurs:  

• The user logs out of the workstation (Windows session)  

• The terminal is turned off, restarted, or rebooted  

• The user stops the OLB Application on the terminal  

2. Log into OTCnet Online.  

• For guidance, refer to the Log In to OTCnet Online PJA 
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_log_on_
otcnet.pdf  

  

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_start_stop_olb.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_start_stop_olb.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_log_on_otcnet.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_log_on_otcnet.pdf
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SECTION V: OLB TROUBLESHOOTING 
To remedy common challenges when completing the OLB configuration and set-up, explore and 
consult the troubleshooting topics below:   

How to Set-Up the OLB: General System Requirements 

Which operating systems are compatible with the OLB Application?  
Windows 11 and Windows 10 (64-bit versions) are supported by OTCnet and the OLB.  
 

Which Internet Explorer versions are compatible with the OLB Application?  
Microsoft Edge, Google Chrome, and Internet Explorer 11 are supported by OTCnet.  

What is the ideal Transport Layer Security (TLS) that should be enabled?  
The TLS 1.2 option must be enabled for all workstations using Windows 10 or Windows 11.  

How much workstation memory is needed?  
At a minimum, 2 GB physical memory is required.  

How much free space is needed?  
100 MB of free disk space is required at minimum. 

How to Set-Up the OLB: Check Processing Requirements  

Which Adobe versions are compatible with OTCnet?  
All versions of Adobe are compatible with OTCnet. Adobe X may require modifications to the web browser 

configuration.  

Which version of Adobe Reader is required at minimum?  
Adobe 7 or higher is required.  

How to Set-Up the OLB: OLB System Requirements  

If you are using Google Chrome or Microsoft Edge, you can skip this step. If you use Internet 

Explorer 11 to process checks or card payments, complete the configuration steps below.  

On June 15, 2022, Microsoft ended support for Internet Explorer 11. Windows 10 and 11 do not support 

Internet Explorer 11. OTCnet users are strongly encouraged to use Google Chrome or Microsoft Edge to 

avoid taking additional actions. 

It is highly recommended that OTCnet support staff and users work with their Agency IT Administrator to 

address any Internet Explorer related configuration challenges. Administrator privileges may be needed.    

How do I configure the Local Intranet zone under the Internet Explorer Security Internet 

Settings?  
Complete the following steps. See Figure 1.  

1. Launch Internet Explorer. 

2. From the Tools menu (refer to the upper right-hand  button), click Internet options. 

3. Click the Security tab. 

4. Select Local Intranet zone. 

5. Ensure the Enable Protected Mode is unchecked. 

6. Click Sites. 

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
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7. In the Local Intranet window, click Advanced. 

8. Enter *.otcnet.for.fiscal.treasury.gov in the Add this website to the zone field. 

9. Click Add. 

10. Click Close.  

Note: Ensure other OTCnet specific websites, such as www.otcnet.for.fiscal.treasury.gov or 

https://doc.ssologin1.fms.treas.gov, are not included in the Local intranet Websites listing. 

 

Figure 1. Local Intranet Configuration 

 

 

 

  

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
http://www.otcnet.for.fiscal.treasury.gov/
https://doc.ssologin1.fms.treas.gov/
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How do I configure the Internet Explorer Compatibility View settings? 
If you are using Google Chrome or Microsoft Edge, skip the steps below. If you use Internet Explorer 

11 to process checks or card payments, see Figure 2 and complete the following configuration steps:  

1. Launch Internet Explorer 11. 

2. From the Tools menu (refer to the upper right-hand  button), click Internet options.  

3. Click Compatibility View Settings. 

4. Under the Websites you’ve added to Compatibility View, remove treas.gov and treasury.gov 

if it listed. 

5. Ensure the Display intranet sites in Compatibility View is unchecked. 

6. Click Close.  
 

Figure 2. Compatibility View Settings Configuration 

 

 

 

 

 

 

 

 

  

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
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When creating the OLB Profile and saving the INI file, can you rename it to the user’s name? 
No, the INI file name must remain the same as it was generated. If the file name is changed, the OLB 

Application will not run.  

How do I know if the OLB was successfully installed?  
Confirm installation by verifying the following areas:   

1. Verify there are Desktop icons for Start OTCnet Local Bridge and Stop OTCnet Local Bridge. 

See Figure 3.  
Figure 3. Start and Stop OTCnet Local Bridge Desktop Icons 

 

 

2. Under All Programs from the Windows Start dropdown, confirm Start OTCnet Local Bridge and 

Stop OTCnet Local Bridge are listed. See Figure 4.  

 
Figure 4. Start Menu - Start and Stop OTCnet Local Bridge 

 

3. Under Programs and Features from the Control Panel, ensure that the OTCnet OLB is listed. 

See Figure 5. 

 

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
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Figure 5. Programs and Features - Listing of Installed Programs 

 

Note: The OLB Installer verifies that Java is installed on the workstation. If Java is not installed, you will 
receive a “Java 8, Java 11, or Java 17 must be installed for the OLB to function. The JAVA_HOME 
environment variable must also be set pointing to the main Java installation folder” message. A Windows 
Administrator must install Java. 
  

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
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How to Create an OLB Profile 

How do I know if I successfully imported my OLB credentials? 
After uploading the appropriate INI file, a confirmation window should appear. See Figure 6.  

Figure 6. Successful User Profile Import Confirmation Window 

 

How do I change my OLB password? 

Complete the following steps. See Figure 7.  

1. After logging into OTCnet Online, click the Administration tab. 

2. Select Manager Users. 

3. Click Create Local Bridge and User Profile. 

4. Ensure Online Local Bridge version 2.2.0 or newer radio button is selected. 

5. Enter a password in the Enter Local Bridge/Offline Password* field. 

6. Enter same password in the Confirm Local Bridge/Offline Password* field. 

7. Click Submit. 

8. Save the INI file. 
Figure 7. Change OLB Password 

 

After changing my OLB password, do I need to import my OLB credentials again?  
Yes, Card Processing, Check Capture, Check Processing and Terminal Configuration Operations users 

will need to import their OLB credentials after changing their OLB passwords.  

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
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How to Start the OLB  

How do I know if I successfully started the OLB Application?  
After entering your OTCnet login ID and OLB password, a confirmation window should appear. See Figure 

8. 

Figure 8. Successful Login Confirmation Window 

 

What should I do when I see the OTCnet Configurable Options window?  
After logging into the OLB Application and OTCnet Online, users will need to select the OTCnet Local 

Bridge Application – OLB radio button from the OTCnet Configurable Options window. See Figure 9.  

Figure 9. OTCnet Configurable Options Window 

 

Note: If a user clicks the OTCnet Local Bridge Application – OLB radio button in error before the OLB 

has been set up, the following steps will reset the system to display the Java Applets/OTCnet Local Bridge 

Application dialog box where the user can then click the Java Applets radio button: 

1. Log into OTCnet. 

2. While logged into OTCnet, copy and paste the following hyperlink: 

https://otcnet.for.fiscal.treasury.gov/otcnet/views/resetSplash.xhtml into the Internet Explorer 

address bar and press Enter on the keyboard. Ensure the ‘S’ in Splash is capitalized.  

3. Click OK. See Figure 10. 

Figure 10. Message from webpage 

 

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
https://otcnet.for.fiscal.treasury.gov/otcnet/views/resetSplash.xhtml
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4. The user will now see the Java Applets/OTCnet Local Bridge Application Dialog Box on return to 
the login page. The defaulted option is now Java Applets, users can click OK and proceed as 
normal.  

  

How do I know if the OLB Application is running?  
After logging into OTCnet Online, check to see if the OLB Communication status bar appears on the 

Check Scan page. See Figure 11 and Figure 12. 
Figure 11. OLB Communication Status Bar for Check Processing 

 

Figure 12. OLB Communication Status Bar for Card Processing 

 

What should I do if the OLB Communication status bar is not showing up on the Check Scan 

page?  
Only the Check Capture Lead Operator (CCLO) and Check Capture Operator (CCO) will see this 

indication on the Check Scan page once the OLB set up is successful. If you are a CCLO or CCO and you 

do not see the Communication status bar, check your OLB system requirements, specifically your Internet 

Explorer Internet options and Compatibility View settings. Ensure the Trusted Sites zone, Local 

Intranet zone, and Compatibility View settings are configured correctly.  

Review the following available resources:  

• The OTCnet System Requirements and Reference Guide (page 4):  

https://fiscal.treasury.gov/files/otcnet/otcnet-sys-req.pdf 

• In this Guide, Section V: OLB Troubleshooting: How to Setup the OLB: OLB System Requirements 

What should I do if the OLB Communication status bar is not showing up on the Card Processing 

page?  
Only the Card Administrator and Card Operator will see this indication on the Card Processing page once 

the OLB set up is successful. If you are a Card Administrator or Card Operator and you do not see the 

Communication status bar, check your OLB system requirements, specifically your Internet Explorer 

Internet options and Compatibility View settings. Ensure the Trusted Sites zone, Local Intranet zone, 

and Compatibility View settings are configured correctly.  

Review the following available resources:  

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
https://fiscal.treasury.gov/files/otcnet/otcnet-sys-req.pdf
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• The OTCnet System Requirements and Reference Guide (page 4):  

https://fiscal.treasury.gov/files/otcnet/otcnet-sys-req.pdf 

• In this Guide, Section V: OLB Troubleshooting: How to Setup the OLB: OLB System Requirements 

 

What should I do if I encounter a terminal configuration message?  
See Figure 13.  

Figure 13. Terminal Configuration Message 

 

New terminals or those newly updated may need to be reconfigured. Refer to the Configure a Check 

Capture Terminal Online PJA: 

https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_configure_a_chk_term.pdf 

What should I check if the OLB Application is not connecting to OTCnet Online?  

Complete the following steps. See   

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
https://fiscal.treasury.gov/files/otcnet/otcnet-sys-req.pdf
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_configure_a_chk_term.pdf
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Figure 14.  

1. Sign into the Start OTCnet Local Bridge with OLB credentials.  

2. Log into OTCnet Online. 

3. Press F12 on the keyboard. 

4. From the Developer Tools pop-up, click the Console tab. 

5. Copy and paste the following into the input textbox: 

ws = new WebSocket('wss://localhost:9043/websockets/olb'); 

ws.onopen = function(){ alert("OLB Connection opened successfully")}; 

ws.onerror = function(e){ alert("Error connecting to OLB" +e)}; 

6. Click the green arrow.  

7. Ensure a Message from the webpage window appears.  

8. Click OK.  

9. Click X to close out the Developer Tools pop-up. 
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Figure 14. Troubleshooting OLB Connection to OTCnet 

 

If an error message appears, the OLB connection is not working properly. See Figure 15. 

Figure 15. Security Message Error 

 

Confirm proper installation of the OLB Setup by:   

1. Ensuring all general system requirements are met  

• Windows 10 or Windows 11 

• Google Chrome, Microsoft Edge, Internet Explorer  

• Installation of Entrust Certification Authority – L1K 

• Installation of Root Certification Authority – G2 

Note: The above Certification Authorities are installed by system default.  

 

2. Ensuring all check processing requirements are met  

• Firmware 4.3.0  

• Adobe Reader 7 or higher  

• Installed Scanner Drivers  

 

3. Ensuring all OLB system requirements are met 

• Internet Explorer users: Configure the Trusted Sites zone under Internet Explorer Security 

settings 

• Internet Explorer users: Configure the Local Intranet zone under the Internet Explorer 

Security settings 

• Internet Explorer users: Configure the Internet Explorer Compatibility View settings  

• Installation of the OLB Certificate  

• The default port settings were utilized (during execution of the OLB Application installation file) 
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• The default server WSS ports are 9043, 9143, 9243, 9343 and 9443. It is recommended to 

use the default server port settings during the OLB installation process. 

• Other alternative default server ports are 44338, 9042, 9043, and 45823. See Figure 16. 
Figure 16. Server Port Settings 

 

4. Reviewing other security settings, such as firewall programs, user permissions, group policy 

settings, etc. are not interfering with access and usage of the OLB Application. 

• Verify any permissions and/or access restrictions 

• Ensure the OLB Application and its ports are not blocked by a local security program or 

firewall settings  

• Confirm whether users have proper permissions on the local computer to connect to the OLB 

Application  

• Determine whether the same OLB connection issues are experienced by other users on the 

shared workstation  

• Check Agency Group Policy settings 

• For Internet Explorer users: Ensure the required Internet Explorer site (i.e. 

*otcnet.for.fiscal.treasury.gov) is not being blocked. 

• Review the OLB logs for additional information 

• OLB log files are located on the local computer in the following folder: C:\OTCnet_olb\log 

Note: Agency IT Administrator may need to provide support.  

SECTION VI: OLB FREQUENTLY ASKED QUESTIONS (FAQS) 
Explore the following FAQs regarding the OLB transition, configuration, and set-up. 

Prepare for the OLB Setup 

Do Deposit Processing users need to use the OLB?  
No, the OLB only impacts Check Processing, Check Capture and Card Processing activities. All Check 

Processing, Check Capturing, and Card Processing users will need to set up their workstations with the 

OLB.  

How will the OLB impact Check Capturing, Check Processing, and Card Processing activities?  
The OLB does not change OTCnet’s functionality or capabilities. Rather, the OLB removes OTCnet’s 

dependency on Java Applets and improves the user experience with faster terminal detection.  
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Who do I contact to find out who my Agency POC is? 
Send an email to the OTCnet Deployment Team at fiscalservice.otcdeployment@citi.com to inquire. In the 

email, include your full name, agency and bureau and any other pertinent information. 

How do we check which version of firmware we have?  
For Windows 10 and 11 users:  

1. Click Start. 

2. Click Window Settings. 

3. Click Control Panel. 

4. Click Programs. 

5. Locate OTCnet Firmware.  

6. Refer to the Version column to determine installed version.  

Do I need to update my Firmware to download the OLB? 
Yes, Firmware 4.3.0 is needed to download and use the latest OLB.  

Which check scanners are compatible with the OLB? 
All scanners currently supported by OTCnet are compatible with the OLB. OTCnet currently supports the 

RDM EC7000i, RDM EC9100i, the Panini I: Deal, and the Panini VisionX scanners. Please note that the 

RDM EC7000i is no longer available for purchase. Please see the OTCnet System Requirements Guide 

for a full compatibility matrix. Contact Customer Support if you encounter issues with your compatibility. 

Is the OLB compatible with Windows 10 and 11 64-bit?  
Yes, the following Operating Systems are supported by OTCnet:  

• Windows 10 and 11 (OTCnet supports the 64-bit version of the operating system)  

Is the OLB compatible with Microsoft Edge or other internet browsers?  
OTCnet supports Google Chrome, Microsoft Edge (version 79 or higher), and Internet Explorer 11 (both 

32-bit and 64-bit versions). 
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Install the OLB Application 

Which roles are authorized to download the OLB Application? 
Check Capture Administrators and Card Administrators are the only authorized users who can download 

the OLB Application.  

Do Check Capture Administrators and Card Administrators need to have Windows Administrator 

privileges to download the OLB Application?  
No, Check Capture and Card Administrators do not need to have Windows Administrator privileges to 

download the OLB Application.  

Who can install the OLB Application installation package?  
Any Check Processing, or Card Processing user (e.g., Check Capture Administrator, Check Capture 

Supervisor, Check Capture Lead Operator, Check Capture Operator, or Card Administrator) can install the 

OLB Application installation package. Administrator privileges are needed to install the OLB Application. It 

is highly recommended that users work with their Agency IT Administrator to complete installation of the 

OLB Application.  

Do users need to have Windows Administrator privileges to install the OLB Application?  
Yes, depending on an Agency’s system and security set-up, most users will likely need to have Windows 

Administrator privileges. It is highly recommended for users to work with their Agency IT Administrator to 

complete installation of the OLB Application.  

We have multiple users using the same workstation, and each user has a different login. Does 

the OLB need to be separately installed? 
The OLB only needs to be installed once as it will install for all Windows profiles. However, the certificate 

will need to be installed for each Windows profile. To install the certificate, it is highly recommended for the 

Agency IT Administrator to use the mmc.exe approach to install the OLB Application for multiple users on 

a shared workstation. If you can’t use the mmc.exe approach, then you can navigate to the 

“olb.otcnet.public.crt” file, double-click on it to view the certificate and then click the “Install Certificate…” 

button to run the Certificate Import Wizard. This allows you to import the certificate into the “Trusted Root 

Certification Authorities” certificate store for each Windows profile where the certificate is not installed. 

Can a user with multiple roles, such as Check Capture Administrator, Check Capture Supervisor, 

Check Capture Operator, Card Administrator, or Card Operator download and install the OLB 

Application and certificate? 
Yes, a user must be a Check Capture Administrator or Card Administrator to download the OLB 

Application. However, any Check Capture user (i.e. Check Capture Administrator, Check Capture 

Supervisor, Check Capture Lead Operator, Check Capture Operator) or Card Processing user (Card 

Administrator, Card Operator) can install the OLB Application if they have Windows Administrator 

privileges. It is highly recommended for users to work with their Agency IT Administrator if they do not have 

Windows Administrator privileges.  

 

With OLB 1.3.0 and higher, The OLB certificate is included in the OLB installer file. You do not have to 

separately install the OLB certificate.  

 

Can my agency install and manage its own Java version? 
Yes, with OLB 2.5.0 and higher, the OLB and Offline will unbundle Java (JRE) from their installation 

packages. OLB and Offline will require a separate JRE, allowing (and requiring) agencies to install and 

manage their own JRE versions on their users’ workstations.  
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Create an OLB Profile 

Who needs to create an OLB profile? 
All Check Processing, Check Capture, and Card Processing users need to create an OLB profile.  

After the OLB Application is installed, will users be able to create and import their own OLB 

credentials? 
Yes, once the OLB Application and certificate are installed, users can create and import their own OLB 

credentials.  

Does each user need to create an OLB profile on a shared workstation?  
Yes, each user needs to create their own individual OLB profile to access and use the OLB Application on 

the shared workstation.  

Does my OLB password need to match my OTCnet Online password? 
No, OLB passwords do not need to match users’ OTCnet Online passwords. 

Do I need to change my OLB password if I changed my OTCnet Online password? 
No, OLB passwords are not linked to users’ OTCnet Online passwords.  

 

How often do I need to change my OLB password?  
OLB passwords never expire. They do not need to be updated.  

Start the OLB  

Is there a way to turn off the message (Java Applets/OLB Dialog Box) that pops up every time 

we login on the other terminal? 
The dialog box does not appear for Card Processing, Google Chrome, or Microsoft Edge users. The Java 

Applets/OLB dialog Box will continue to appear for Check Capture and Check Processing users who use 

Internet Explorer and have not yet installed the OLB Application.  

Once the OLB Application is installed, users can select the OLB radio button from the Java Applets/OLB 

Dialog Box. When the OLB radio button is selected, the Java Applets/OLB Dialog Box will no longer 

appear. Users should continue to select the Java Applets radio button until the OLB Application has 

been installed.  

Do I need the OLB to configure a check capture or card terminal?  
Yes, if you are configuring a check capture or card terminal, you must first start the OLB Application. If you 

have not started the OLB Application, you will receive the following message: “Terminal detection failed. 

Please ensure that the OLB Application is running.”  

When do I need to log into the OLB Application? 
The OLB Application is required to perform Card Processing, Check Capture, Check Processing and 

Terminal Configuration Operations. If you are a Check Capture Administrator, Check Capture Supervisor, 

Check Capture Lead Operator, Check Capture Operator, Card Administrator, or Card Operator, the OLB 

Application must be started on the terminal to performing these operations. There is no “timeout” with the 

OLB Application (i.e., a suspension or break in OTCnet activity). Therefore, the OLB Application will stay 

connected unless one of the following occurs:  

• The user logs out of the workstation (Windows session)  

• The terminal is turned off, restarted, or rebooted  

• The user stops the OLB Application on the terminal 
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SECTION VII: ADDITIONAL RESOURCES 

Helpful Links 
OTCnet FAQs 
https://www.fiscal.treasury.gov/otcnet/faqs.html    

OTCnet OLB Information and Resources  
https://www.fiscal.treasury.gov/otcnet/local-bridge-information-resources.html 

 

OTCnet System Requirements and Reference Guide  
https://fiscal.treasury.gov/files/otcnet/otcnet-sys-req.pdf 

OTCnet OLB Fact Sheet 
https://www.fiscal.treasury.gov/files/otcnet/OTCnetLocalBridge(OLB)FactSheet.pdf 

OTCnet OLB Information Webinar Presentation 
https://www.fiscal.treasury.gov/files/otcnet/OTCnetLocalBridge(OLB)WebinarPresentation.pdf 

OTCnet OLB FAQs Sheet 
https://www.fiscal.treasury.gov/files/otcnet/OTCnetLocalBridge(OLB)RolloutFrequentlyAskedQuestions.pdf 

Training Resources  
Role Web-Based Training 
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/course_OTC/index.htm 

All Training Modules 
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/course_OTC/menu_all.htm 

YouTube Videos 
https://www.youtube.com/channel/UCrezr4h8sW9zB6IEoKwBqRQ/videos 

 

  

Printable Job Aids (PJAs) and Videos to Review  
Download Firmware PJA 
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_download_firmware.pdf   

Install Firmware PJA 
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_install_firmware.pdf 

Start and Stop the OTCnet Local Bridge (OLB) Application PJA 
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_start_stop_olb.pdf 

Start and Stop the OTCnet Local Bridge (OLB) Application Video 
https://youtu.be/fw8HHfWVmUI?list=TLGGYwa7OthCxDAyNDA1MjAyMg 

Download the OTCnet Local Bridge (OLB) Application PJA 
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_download_olb.pdf 
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Install the OTCnet Local Bridge (OLB) Certificate PJA  
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_install_olb_certificate.pdf 

Install the OTCnet Local Bridge (OLB) Application PJA 
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_install_OLB.pdf  

Create the OTCnet Local Bridge (OLB) Profile PJA 
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_create_olb_profile.pdf 

Create the OTCnet Local Bridge (OLB) Profile Video  

https://youtu.be/hrFsaPbzbVc?list=TLGGNnwVwjmLxfMyNDA1MjAyMg 

Import OTCnet Local Bridge (OLB) Credentials PJA  
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_import_olb_credentials.pdf 

Import OTCnet Local Bridge (OLB) Credentials Video 

https://youtu.be/J5lYV4I0bdc?list=TLGGvHrEM-qzB7gyNDA1MjAyMg 

Configure a Check Capture Terminal PJA  
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_configure_a_chk_term.pdf 

Log into OTCnet Online PJA 
https://fiscal.treasury.gov/otcnet/training/wbt/content/_resources/PJA/pja_log_on_otcnet.pdf 

 

User Guides  
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/course_OTC/library.htm  
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SECTION VIII: ADDITIONAL SUPPORT 
For further assistance, reach out to the following support staff:   

OTCnet Deployment Team  

Telephone: 1-866-945-7920, option 4 

Email: FiscalService.OTCDeployment@citi.com  

Please contact the Deployment Team if your agency is currently in the OLB rollout testing phase 

and you need assistance with OLB testing.  

 

OTCnet Customer Support Team 

Telephone: 1-866-945-7920, option 2 

Email: FiscalService.OTCChannel@citi.com 

Please contact Customer Support if your agency has successfully tested the OLB Application 

and you need assistance, or if you have any general questions. 
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 OTCnet Printable Job Aid 

Import OTCnet Local Bridge (OLB) Credentials 

To import OTCnet Local Bridge (OLB) credentials, complete the following steps: 

1. Double-click the Start OTCnet Local Bridge icon located on the workstation desktop. 

Or 

Click Start>Programs>Start OTCnet Local Bridge. 

 

If the icon does not reside in either location, contact your Check Capture Administrator 
(CCA) or Card Administrator (CA). They can help with the following steps: 

• Completing the steps required to install the OLB application on the workstation 

• Installing the OLB Application and OLB certificate for the check capture workstation 
(applicable for OLB versions 1.2.0 and older) 

• Creating your OLB profile 

• Importing your OLB credentials 

 

2. The OTCnet Local Bridge Startup window appears. Click the File menu. 

3. Click Import User Profile as shown in Figure 1.  

Figure 1. Start OTCnet Local Bridge Startup 

 

4. The Select User Profile File window appears. Navigate to the location on the workstation 
where the OLB credential file was saved. Select the file and click Import.  

 

The default location on the Select User Profile File window is the user’s My Documents 
folder. 

 

5. A Successfully imported user profile message appears. Click OK. Once you have 
successfully imported your OLB credentials, proceed with starting the OLB application on 
the workstation. 

Application Tip 

 

Application Tip 
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